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TROUBLE

| If you click below the
table to deselect it,
the active tab
changes to the Home
tab. If necessary, click
in the table, then
click the Table Tools
Layout tab to con-
tinue with the steps
in this lesson.

QUICR TIP
To split a table in
two, click the row
you want to be the
first row in the sec-
ond table, then click
the Split Table but-
ton in the Merge
group.
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't | Splitting and Merging Cells

A convenient way to change the format and structure of a table is to merge and split the table cells. When
you merge cells, you combine adjacent cells into a single larger cell. When you split a cell, you divide an
existing cell into multiple cells. You can merge and split cells using the Merge Cells and Split Cells com-
mands in the Merge group on the Table Tools Layout tab. You merge cells in the first column to
create a single cell for each ad type—Web, Print, and Misc. You also add a new row to the bottom of the
table, and split the cells in the row to create three new rows with a different structure.

1. Select the two Web cells in the first column of the table, click the Merge Cells button in
the Merge group on the Table Tools Layout tab, then deselect the text
The two Web cells merge to become a single cell. When you merge cells, Word converts the text in each cell
into a separate paragraph in the merged cell.

2. Select the first Web in the cell, then press [Delete]

3. Select the three Print cells in the first column, click the Merge Cells button, type Print,
select the two Misc. cells, click the Merge Cells button, then type Misc.
The three Print cells merge to become one cell and the two Misc. cells merge to become one cell.

4. Click the Bus stops cell, then click the Insert Below button in the Rows & Columns group
A row is added to the bottom of the table.

5. Select the first three cells in the new last row of the table, click the Merge Cells button,
then deselect the cell
The three cells in the row merge to become a single cell.

6. Click the first cell in the last row, then dlick the Split Cells button in the Merge group
The Split Cells dialog box opens, as shown in Figure E-12. You use this dialog box to split the selected cell or
cells into a specific number of columns and rows.

7. Type 1in the Number of columns text box, press [Tab], type 3 in the Number of rows
text box, click OK, then deselect the cells
The single cell is divided into three rows of equal height. When you split a cell into multiple rows, the width
of the original column does not change. When you split a cell into multiple columns, the height of the orig-
inal row does not change. If the cell you split contains text, all the text appears in the upper-left cell.

8. Click the last cell in the Cost column, click the Split Cells button, repeat Step 7, then save
your changes

The cell is split into three rows, as shown in Figure E-13. The last three rows of the table now have only two
columns.
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FIGURE E-12: Split Cells dialog box

& #

Type | Location Details

Chi il i run of site, 1 million

o Web
. Hellochicago.com | Tile,

Hember of colmes: (3 =
i

Chicago Tribune 1 full

Print | Chicago Sun Times % paf [ Merpe cels before spbt

ChicagoMagazine | 2724 LB [

s Taxi tops 60 taxis, 2 weeks

Cells cre_ated - i

by merging Bus stops 50 bus shelter panels, 2 weeks
other cells &

3
=]
=
o
N
(=]
(=}
N

FIGURE E-13: Cells split into three rows
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Changing cell margins

By default, table cells have .08" left and right cell margins with no
spacing between the cells, but you can adjust these settings for a
table using the Cell Margins button in the Alignment group on the
Table Tools Layout tab. First, place the insertion point in the table,
and then click the Cell Margins button to open the Table Options
dialog box. Enter new settings for the top, bottom, left, and right
cell margins in the text boxes in the Default cell margins section of

the dialog box, or select the Allow spacing between cells check box
and then enter a setting in the Cell spacing section to increase the
spacing between table cells. You can also deselect the Automatically
resize to fit contents check box in the Options section of the dialog
box to turn off the setting that causes table cells to widen to fit the
text as you type. Any settings you change in the Table Options dia-
log box are applied to the entire table.
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Performing Calculations
in Tables

If your table includes numerical information, you can perform simple calculations in the table. The Formula
command allows you to quickly total the numbers in a column or row, and to perform other standard cal-
culations, such as averages. When you calculate data in a table using formulas, you use cell references to
refer to the cells in the table. Each cell has a unique cell reference composed of a letter and a number;
the letter represents its column and the number represents its row. For example, the cell in the third row of
the fourth column is cell D3. Figure E-14 shows the cell references in a simple table. You use the
Formula command to calculate the total cost of the Chicago ad campaign. You also add information about
the budgeted cost and create a formula to calculate the difference between the actual and budgeted costs.

QUICK TIP
If a column or row
contains blank cells,
you must type a zero
in any blank cell
before using the
SUM function.

QUICK TIP

To change a field
result to regular text,
click the field to
select it, then press
[Ctri](Shift][F9].

QUICR TIP
Cell references are
determined by the
number of columns
in each row, not by

the number of

columns in the table.
Therefore, rows 9
and 10 have only
two columns.
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1. Click the first blank cell in column 1, type Total Cost, press [Tab], then click the Formula
button in the Data group on the Table Tools Layout tab
The Formula dialog box opens, as shown in Figure E-15. The SUM function appears in the Formula text box
followed by the reference for the cells to include in the calculation, (ABOVE). The formula =SUM(ABOVE)
indicates that Word will sum the numbers in the cells above the active cell.

2. Click OK
Word totals the numbers in the cells above the active cell and inserts the sum as a field. You can use the SUM

function to quickly total the numbers in a column or a row. If the cell you select s at the bottom of a column
of numbers, Word totals the column. If the cell is at the right end of a row of numbers, Word totals the row.

3. Select 12,000 in the cell above the total, then type 13,500
If you change a number that is part of a calculation, you must recalculate the field result.

4. Press [v], then press [F9]
When the insertion point is in a cell that contains a formula, pressing [F9] updates the field result.

5. Press [Tab], type Budgeted, press [Tab], type 113,780, press [Tab), type Difference, then
press [Tab]
The insertion point is in the last cell of the table.

6. Click the Formula button
The Formula dialog box opens. Word proposes to sum the numbers above the active cell, but you want to
insert a formula that calculates the difference between the actual and budgeted costs. You can type simple
custom formulas using a plus sign (+) for addition, a minus sign (-) for subtraction, an asterisk (*) for multi-
plication, and a slash (/) for division.

7. Select =SUM(ABOVE) in the Formula text box, then type =B9-B10
You must type an equal sign (=) to indicate that the text following it is a formula. You want to subtract the
budgeted cost in the second column of row 10 from the actual cost in the second column of row 9; there-
fore, you type a formula to subtract the value in cell B10 from the value in cell B9.

8. Click OK, then save your changes
The difference appears in the cell, as shown in Figure E-16.
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FIGURE E-14: Cell references in a table
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FIGURE E-15: Formula dialog box
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Working with formulas

In addition to the SUM function, Word includes formulas for averag-
ing, counting, and rounding data, to name a few. To use a Word for-
mula, click the Paste function list arrow in the Formula dialog box,
select a function, and then insert the cell references of the cells you
want included in the calculation in parentheses after the name of
the function. When entering formulas, you must separate cell refer-
ences by a comma. For example, if you want to average the values

Column D
(fourth
column)

2
o

=

o
N
(=3
=}
N

Cell B9
Cell B10

B9-B10=1,270

in cells A1, B3, and C4, enter the formula =AVERAGE(A1,B3,C4). You
must separate cell ranges by a colon. For example, to total the val-
ues in cells A1 through A9, enter the formula =SUM(AT:A9). To dis-
play the result of a calculation in a particular number format, such as
a decimal percentage (0.00%), click the Number format list arrow in
the Formula dialog box and select a number format. Word inserts

the result of a calculation as a field in the selected cell.
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Applying a Table Style

Adding shading and other design elements to a table can help give it a polished appearance and make the
data easier to read. Word includes built-in table styles that you can apply to a table to format it quickly. Table
styles include borders, shading, fonts, alignment, colors, and other formatting effects. You can apply a table
style to a table using the buttons in the Table Styles group on the Table Tools Design tab. You want
to enhance the appearance of the table with shading, borders, and other formats, so you apply a table style
to the table. After applying a style, you change the theme colors to a more pleasing palette.

TROUBLE

If your gallery of
table styles does not
match the figure,
use the ScreenTips
to help you locate
the correct style.

QUICK TIP
Click Clear in the
gallery of table styles
to remove all bor-
ders, shading, and
other style elements
from the table.

TROUBLE
When you select the
Type column, the
first column in the
last three rows is also
selected.
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. Click the Table Tools Design tab

The Table Tools Design tab includes buttons for applying table styles and for adding, removing, and cus-
tomizing borders and shading in a table.

Click the More button [=]in the Table Styles group

The gallery of table styles opens, as shown in Figure E-17. You point to a table style in the gallery to preview
the style applied to the table.

Move the pointer over several styles in the gallery, then click the Light Grid - Accent 2 style
The Light Grid - Accent 2 style is applied to the table, as shown in Figure E-18. Because of the structure of
the table, this style neither enhances the table nor helps make the data more readable.

. Click the More button [Z]in the Table Style group, then dlick the Light List - Accent 2 style

This style works better with the structure of the table, and makes the table data easier to read.

In the Table Style Options group, click the First Column check box to clear it, then click
the Banded Columns check box to select it

The bold formatting is removed from the first column and column borders are added to the table. When the
banded columns or banded rows setting is active, the odd columns or rows are formatted differently from
the even columns or rows to make the table data easier to read.

. Click the Page Layout tab, click the Theme Colors list arrow [/ in the Themes group,

then click Origin in the gallery that opens
The color palette for the document changes to the colors used in the Origin theme, and the table color
changes to Ice Blue.

Click the Table Tools Design tab, click the More button [=]in the Table Styles group,
then click the Light List - Accent 1 style

The table color changes to Blue-Gray. Notice that the alignment of the text in the table changed back to top
left when you applied a table style.

Click the Table Tools Layout tab, click the table move handle [} to select the table, click
the Align Center Left button [=] in the Alignment group, select the Type column, click the
Align Center button =l in the Alignment group, select the Cost column, then click the
Align Center Right button =] in the Alignment group

First, the data in the table is left-aligned and centered vertically, then the data in the Type column is cen-
tered, and finally the data in the Cost column is right-aligned.

. Select the last three rows of the table, click the Bold button [B] on the Mini toolbar, then

click =]

The text in the last three rows is right-aligned and bold is applied.

Select the first row of the table, click the Center button [Z] on the Mini toolbar, click the
Font Size list arrow on the Mini toolbar, click 14, deselect the row, then save your
changes

The text in the header row is centered and enlarged, as shown in Figure E-19. You can also use the alignment
buttons in the Paragraph group on the Home tab to change the alignment of text in a table.
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FIGURE E-17: Gallery of table styles
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FIGURE E-19: Light List — Accent 1 style (Origin theme) applied to table
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Using tables to lay out a page

Tables are often used to display information for quick reference and
analysis, but you can also use tables to structure the layout of a
page. You can insert any kind of information in the cell of a table—
including graphics, bulleted lists, charts, and other tables (called
nested tables). For example, you might use a table to lay out a
résumé, a newsletter, or a Web page. When you use a table to lay
out a page, you generally remove the table borders to hide the table
structure from the reader. After you remove borders, it can be help-

Gallery of table
styles (your display
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ful to display the table gridlines onscreen while you work. Gridlines
are blue dotted lines that show the boundaries of cells, but do not
print. If your document will be viewed online—for example, if you
are planning to e-mail your résumé to potential employers—you
should turn off the display of gridlines before you distribute the doc-
ument so that it looks the same online as it looks when printed. To
turn gridlines off or on, click the View Gridlines button in the Table
group on the Table Tools Layout tab.
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QUICK TIP
In cells with vertical
text, the I-beam
pointer is rotated 90
degrees, and the
buttons in the
Alignment group
change to vertical
alignment.

TROUBLE
If gridlines appear,
click the Borders list
arrow, then click
View Gridlines to
turn off the display.

On the Borders
menu, click the but-
ton that corresponds
to the border you
want to add or
remove.
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Creating a Custom Format
for a Table

You can also use the formatting tools available in Word to create your own table designs. For example, you
can add or remove borders and shading, vary the line style, thickness, and color of borders, and change
the orientation of text from horizontal to vertical. 1 You adjust the text direction, shading, and bor-
ders in the table to make it easier to understand at a glance.

1. Select the Type and Location cells in the first row, click the Merge Cells button in the
Merge group on the Table Tools Layout tab, then type Ad Location
The two cells are combined into a single cell containing the text “Ad Location.”

Select the Web, Print, and Misc. cells in the first column, click the Bold button [B] on the
Mini toolbar, click the Text Direction button in the Alignment group twice, then deselect
the cells

The text is rotated 270 degrees.

Position the pointer over the right border of the Web cell until the pointer changes to
«|}», then drag the border to approximately the %' mark on the horizontal ruler
The width of the column containing the vertical text narrows.

. Place the insertion point in the Web cell, click the Table Tools Design tab, then click the
Shading list arrow in the Table Styles group
The gallery of shading colors for the Origin theme opens.

. Click Light Yellow, Accent 4 in the gallery as shown in Figure E-20, click the Print cell,
click the Shading list arrow, click Lime, Accent 3, click the Misc. cell, click the Shading list
arrow, then click Ice Blue, Accent 2
Shading is applied to each cell.

. Drag to select the six white cells in the Web rows (rows 2 and 3), click the Shading list
arrow, then click Light Yellow, Accent 4, Lighter 40%

Repeat Step 6 to apply Lime, Accent 3, Lighter 40% shading to the Print rows and Ice
Blue, Accent 2, Lighter 40% shading to the Misc. rows
Shading is applied to all the cells in rows 1-8.

. Select the last three rows of the table, click the Borders list arrow in the Table Styles group,
click No Border on the menu that appears, then dlick in the table to deselect the rows
The top, bottom, left, and right borders are removed from each cell in the selected rows.

. Click the Pen Color list arrow in the Draw Borders group, click Blue-Gray, Accent 1, select
the Total Cost row, click the Borders list arrow, click Top Border, click the 113,780 cell,
click the Borders list arrow, then click the Bottom Border
The active pen color for borders changes to Blue-Gray, Accent 1. You use the buttons in the Draw Borders
group to change the active pen color, line weight, and line style settings before adding a border to a table. A
top border is added to each cell in the Total Cost row, and a bottom border is added below 113,780. The
completed table is shown in Figure E-21.

10. Press [Ctrl][Home], press [Enter], type your name, save your changes, print a copy of the
document, close the document, then exit Word
Press [Enter] at the beginning of a table to move the table down one line in a document.
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Drawing a table

The Word Draw Table feature allows you to draw table cells exactly
where you want them. To draw a table, click the Table button on
the Insert tab, and then click Draw Table. If a table is already started,
you can click the Draw Table button in the Draw Borders group on
the Table Tools Design tab to turn on the Draw pointercf?? and then
click and drag to draw a cell. Using the same method, you can draw
borders within the cell to create columns and rows, or draw addi-
tional cells attached to the first cell. Click the Draw Table button to

turn off the draw feature. The borders you draw are added using the
active line style, line weight, and pen color settings.

If you want to remove a border from a table, click the Eraser but-
ton in the Draw Borders group to activate the Eraser pointer &,
and then click the border you want to remove. Click the Eraser but-
ton to turn off the erase feature. You can use the Draw pointer and
the Eraser pointer to change the structure of any table, not just the
tables you draw from scratch.
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